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Introducción

Hasta hace unos años atrás el diseño web dependía completamente de Adobe, debido a la aplicación 
Flash que permi  a implementar si  os web completos y con un alto nivel de profesionalismo. Pero 
como todo  ene un inicio y un fi n, el uso de Flash se dejó de lado cuando los disposi  vos móviles 
permi  eron el acceso a las páginas web y estas no se mostraban amigables con dichos disposi  vos. 
Debido a ello, la misma empresa Adobe manifestó que ya no con  nuaría con el desarrollo de Flash. 
Es aquí justamente donde ingresa el HTML5, que suple casi todas las necesidades de los diseñadores 
web y, lo más importante, es absolutamente compa  ble con todos los disposi  vos que permitan ver 
un documento web.

HTML5 es la tecnología del futuro que permi  rá modernizar la web. Ha provisto de muchas funciones 
que suplen fácilmente a Flash, y lo más importante es que no requiere la instalación de ningún 
plugin para ser usado, ya que es compa  ble con la mayoría de disposi  vos. 

Con respecto a los desarrolladores web, estos podrían experimentar cambios en el navegador, ya 
que HTML5 provee nuevas funciones. Asimismo, estas funciones hacen que “la cultura HTML” sea 
mucho más ordenada en comparación con su predecesor. Es así que la W3C, la cual defi ne estándares 
técnicos y directrices, sigue trabajando en HTML5 para poder elaborar un nuevo estándar que sea 
compa  ble con cualquier navegador web; para ello agrega incluso funciones tác  les a su lenguaje. 

También debemos considerar que para realizar un trabajo profesional en la web, HTML5 no trabaja 
solo: necesita de otras tecnologías de apoyo, como JavaScript, JQuery, CSS3, etc., juntos alcanzan 
un desarrollo efi caz en el diseño web. En este libro se ha planteado el obje  vo principal de conocer 
todos los elementos que componen al HTML5 y al CSS3, que son las herramientas fundamentales 
para el diseño de la interfaz.

Por todo lo mencionado anteriormente, podemos decir que en poco  empo HTML5 será considerado 
como el único lenguaje de programación que permi  rá  implementar webs rápidas y ligeras, lo 
cual es importante para los disposi  vos móviles. Esto es posible gracias a sus nuevas e  quetas. 
Además, se podrá navegar por un documento que no necesariamente esté registrado en un servidor 
web, y podrá ser trabajado localmente, es decir, de manera offl  ine. Hay muchas funciones que se 
seguirán implementando para HTML5, las cuales debemos tomar en cuenta para obtener un buen 
desempeño en la elaboración de si  os web.

La importancia de un libro como este radica en que se propone instruir de manera sencilla, pero 
rigurosa, el modo de implementar páginas web profesionales mediante HTML5 y CSS3. Por ello 
el público al que va dirigido está conformado por personas que se inician en el diseño de páginas 
web, estudiantes de informá  ca y público en general. Asimismo, encontrarán que el libro se divide 
en nueve capítulos, en los cuales se expondrán los conceptos básicos del diseño web, y también se 
presentarán algunos casos desarrollados que ilustrarán cada uno de los procesos.
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CAP. 1:  INTRODUCCIÓN  AL DISEÑO WEB CON HTML5 Y CSS3 19

Hoy en día, la Internet se ha vuelto un elemento muy importante de nuestras vidas. ¿Se ha puesto 
a pensar cómo era su vida co  diana antes de que se generalizara el uso de Internet? Recuerde que 
no teníamos redes sociales, usábamos la línea telefónica para formar una red; ni teníamos videos de 
YouTube, comprábamos CD, DVD y, si somos personas de más experiencia, podríamos hablar de videos 
en VHS. Tampoco teníamos televisión digital en línea; nosotros hemos visto videos en televisión de 
blanco y negro. Incluso si solo tomamos en cuenta el concepto de escuchar música en cualquier lugar 
donde nos encontremos, nos daremos cuenta de que hacemos las mismas ac  vidades que antes, pero 
ahora usamos elementos muchos más modernos y rápidos. Por ejemplo, las páginas web, que también 
cambiaron su concepto inicial, que era el de informar solamente por medio de textos e imágenes, para 
conver  rse en un medio importante tanto en nuestra vida personal como laboral. 

Dentro del grupo de personas que infl uyeron en esta 
tendencia estuvo Tim Berners-Lee, que introdujo 
la idea del HTML, en 1989. Su idea surgió debido 
a las defi ciencias que presentaba la búsqueda de 
información en la Internet y debido, también, a 
la necesidad humana de mejorar lo que se  ene. 
Berners-Lee propuso dos tecnologías para mejorar 
la experiencia en la web: el HTTP y el HTML.

Si analizamos el concepto de HTTP veremos que 
guarda relación con la necesidad de transferir 
información  de cualquier  po  por la web. Su nombre 
proviene de las iniciales de HyperText Transfer 
Protocol. El HTTP es un protocolo de transferencia 
usado para las computadoras que son servidores 
web; estas reciben una pe  ción de usuario, como, 
por ejemplo, visualizar una determinada página 
web. Notaremos que siempre inicia con “h  p://”, 
lo cual hace referencia al protocolo que se usará 
cuando se realice la pe  ción al servidor web, con lo que se conver  rá y mostrará un documento HTML 
en el navegador web del usuario, ya sea Internet Explorer, Google Chrome, Mozilla Firefox, etc.

La segunda tecnología propuesta fue el HTML, que representa un lenguaje de marcado basado en 
e  quetas. Su principal labor es indicarle al navegador web cómo debe mostrar el documento web 
solicitado por un determinado usuario. HTML abrió el camino a lo que hoy conocemos como navegar 
por la web, pues con  ene e  quetas que permiten confi gurar una navegación fl uida entre muchos 
documentos web que se encuentran en la red. La unión de las dos tecnologías mencionadas hace 
que la experiencia de usar Internet sea rápida y sencilla, lo que hace que el usuario navegue lo más 
cómodamente posible.

Tim Berners-Lee fundó el W3C (llamado así por las iniciales del Consorcio World Wide Web), que 
instruyó a los usuarios de todo el mundo en el el uso del HTML. Ofreció 4 versiones iniciales y un nuevo 
estándar, llamado HTML5, el cual permi  rá revolucionar la experiencia web en el planeta. Este libro 
está preparado para explicar los nuevos lineamientos que presenta HTML5, además con  ene guías 
prác  cas que han sido desarrolladas paso a paso tomando en cuenta las aplicaciones estándar y de 
mayor demanda entre los diseñadores web. 

Fig. 1.1 Tim Berners-Lee
Fuente: <h  p://www.dailystormer.com/berners-lee-calls-
for-internet-bill-of-rights/>

Fig 1 1 Tim Berners-Lee
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1.1    LAS VERSIONES DEL HTML

Se puede decir que HTML5 surge de la inicia  va que tuvo la empresa IBM, que propuso su lenguaje 
web llamado GML (Generalized Markup Language), en español: Lenguaje Generalizado de Marcado. 
Este defi nía cómo debían comportarse los lenguajes de marcado, pero no proponía el uso de e  quetas, 
y es así como empieza a desarrollarse HTML.

A con  nuación, presentamos algunas versiones del HTML de acuerdo a su año de aparición:  

1.2    LOS NAVEGADORES Y SUS DIFERENCIAS

Empezaremos por explicar el porqué del término “navegador”. Intentemos ubicarnos imaginariamente 
en el espacio marino. Sabemos, por lógica, que en él podemos desplazarnos mediante un barco o un 
bote. Si nos ubicamos en algo más cercano a nosotros, como una autopista, nos daremos cuenta de 
que, en ese entorno, nada mejor que un automóvil para desplazarnos. Sucede algo parecido en la 
Internet, porque es como una autopista de información por la que debemos desplazarnos de la mejor 
manera posible. De allí proviene el término navegador: cuando estemos en busca de información, 
emplearemos uno para “navegar” por las dis  ntas páginas web. 

Aprovecharemos para mencionar el navegador más veloz del mundo llamado Earthrace, cuyo 
diseño es un ejemplo efi ciente del uso de tecnologías amigables para el medio ambiente y el uso 
de biocombus  bles, tales como el biodiesel. Sus motores fueron diseñados para mantener bajas 
emisiones de gas, e incluyen caracterís  cas tales como pintura no tóxica para el medio ambiente y un 
diseño efi ciente en el casco.

1995 Se formaliza el HTML 2.0, y con ello la sintaxis y la mayoría de las reglas que se encuentran 
actualmente implementadas.

1997 HTML 3.2 fue ignorado durante mucho tiempo por las empresas que proveían  navegadores, 
debido a que ellas implementaban sus propias etiquetas.

1998 Bajo la presión de la adopción de los estándares web, se otorga peso a las recomendaciones del 
W3C y se promocionan navegadores basados en dichos estándares.

1999 Se estabiliza la sintaxis y la estructura del HTML 4.0, el cual se convierte en el modelo estándar 
para la web.

2000 Nace el XHTML 1.0, diseñado para adaptar el HTML a XML. Uso de DTD para renderizar como 
HTML.

2000-2004 El incremento de las conexiones en el ancho de banda es alto, lo que produce una demanda 
en el campo del desarrollo de aplicaciones y multimedias, donde tecnologías como Flash y Ajax 
obligaban a trabajar en la especificación XHTML 2.0.

2004 No satisfechos con la dirección de XHTML, Apple, Mozilla y Opera proponen evolucionar el 
estándar HTML 4.0. Aunque son rechazados, forman el WHATWG (Web Hypertext Application 
Technology Working Group).

2005 Se publica el borrador de trabajo Web Applications 1.0.

2007 El W3C adopta el trabajo de WHATWG en un nuevo capítulo, y publican lo que sería el borrador 
de trabajo de HTML5.

2009 Última llamada expedida para el proyecto de trabajo de HTML5. El W3C no renueva XTML 2.0.

2010 Este año se presenta el primer borrador HTML5 y se prevé un alcance total para el 2022.
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Fig. 1.2 Earthrace
Fuente: < h  p://inhabitat.com/earthrace-boat-travels-around-the-world-
in-60-days/>

Fue construido para romper el record de circunnavegación del globo terráqueo usando solo 
combus  bles renovables, el record actual es de 74 días, 20 horas y 58 minutos, impuesto por el barco 
británico “Cable & Wireless” en 1998.

La Internet es una red de redes que comparte gran can  dad de contenidos, es por este mo  vo que 
necesitamos un buen navegador. Seguramente usted ha usado muchos navegadores web y, al fi nal, ha 
elegido uno o quizás dos; por ejemplo, nosotros optamos por usar el Google Chrome o Mozilla Firefox 
solo por cues  ones de comodidad. Desde este punto de vista, debemos agradecer a las empresas que 
se dedican a desarrollar navegadores (como Microso   o Google) porque nos brindan facilidades para 
u  lizar la Internet.

Veamos a con  nuación una imagen que muestra cuáles son los navegadores más usados; le invitamos 
a visitar la URL h  p://gs.statcounter.com, donde podrá apreciar la estadís  ca global entre los 
navegadores más usados.

Fig. 1.3 Estadís  ca global entre los navegadores más usados
Fuente: <h  p://gs.statcounter.com>
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Los navegadores más usados, como Chrome o Firefox, no 
están fuera de nuestro alcance; hoy en día existen si  os 
web en los que se pueden descargar sus versiones más 
actualizadas.

Si nos preguntamos qué atributos o caracterís  cas 
deben presentar los navegadores web, hay mucho por 
considerar. Le ayudaremos mostrando cuáles son algunas 
de las caracterís  cas importantes, como: 

1.2.1    Tiempo de carga

Cuando un navegador 
muestra rapidez 
en la entrega de su 
información, aumenta 
la sa  sfacción del 
usuario y mejora la 
calidad general de 
la web. No debemos 
dejar de considerar 
que este factor no solo es tarea del navegador, sino también del  po de computadora, de la velocidad 
de su proveedor de Internet, etc. Sin embargo, aun así podemos dis  nguir diferencias entre los 
navegadores.

En el siguiente cuadro se pueden observar los  empos de renderización:

Fig. 1.4 Google Chrome versus Mozilla Firefox
Fuente: 
<http://www.3djuegos.com/foros/tema/18351235/0/
google-chrome-vs-mozilla-fi refox/ >

G  C M  F F I  E

Chrome suele ser más 
rápido, con un tiempo de 
carga de 6.906 segundos

El tiempo de carga de 
Firefox es de 6.395 
segundos.

IE tiene un tiempo de carga 
de 6.392 en la versión IE10; 
las versiones anteriores 
eran demasiado lentas.

Fig. 1.5 Velocidad de carga entre los navegadores web
Fuente: <www.genbeta.com/>

1.2.2    Entorno de trabajo

Se puede decir que estamos acostumbrados al entorno que nos ofrece Microso   en todas sus 
aplicaciones, pero los navegadores han propuesto algunos cambios que los hacen atrac  vos para el 
usuario, tal como se puede observar en el siguiente cuadro: 
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1.2.3    Ventanas emergentes

Seguramente alguna 
vez, cuando navegaba 
por Internet, le 
apareció una ventana 
pequeña. Estas son las 
ventanas emergentes 
o pop-ups, y pueden 
ser administradas por 
los navegadores de las 
siguientes maneras:

1.3    HTML5 Y SUS NOVEDADES

HTML5 es la quinta versión del lenguaje HTML; principalmente, representa la 
forma en que se mostrará la información en el navegador de Internet y determina 
la manera en la que los usuarios podrán interactuar con ella. Ha sido desarrollado 
por Ian Hickson, representante de Google Inc., y David Hya  , de la no menos 
conocida Apple Inc.

HTML5 es el resultado de agrupar las especifi caciones (en  éndase por 
especifi cación un lenguaje probado y usado) relacionadas al desarrollo web, como:

G  C M  F F I  E

Chrome cuenta con una interfaz 
muy simple y ligera. Cuando se abre 
una pestaña, se muestra la página 
de inicio del navegador y, a la vez, 
las miniaturas de los 9 últimos  
sitios web. También presenta una 
barra de direcciones que permite 
autocompletar texto y sugiere la 
búsqueda de páginas populares.

Firefox muestra una barra de 
direcciones que registra todas las 
aplicaciones de uso frecuente. Cuenta 
con un menú de opciones que permite 
administrar el texto mostrado; permite, 
por ejemplo, seleccionar para arrastrar, 
o copiarlo. Cuenta también con un 
cuadro combinado que muestra una 
lista predeterminada de sitios web.

IE no ha cambiado mucho 
desde sus versiones 
anteriores, pero hoy en 
día ya no presenta barra 
de herramientas ni menú 
visible de opciones.

Según S. Ezerzer, HTML, o Lenguaje de Marcado de Hipertexto, es el lenguaje madre 
y básico de todos los sitios web. Su función principal es dar formato, especialmente a 
los textos que forman parte de un documento web, todo esto basado en un conjunto de 
etiquetas con funciones específicas. 

El HTML contribuye al aspecto de los textos, lo cual hace más llamativo a un documento 
web y, además, muestra contenidos como videos, sonido o imágenes. Por otra parte, no 
tiene la capacidad de interactuar con variables o bases de datos, como lo hace realmente 
un Lenguaje de Programación.

Aun los sitios web con contenidos complejos (por ejemplo, sistemas de desarrollo, que 
manejan bases de datos y contenidos dinámicos promovidos por lenguajes de programación 
web como PHP o ASP), envían al navegador web un código HTML puro (Ezerzer, 2012).

G  C M  F F I  E

Chrome, mediante la 
opción “Herramientas”, 
puede inhabilitar las 
ventanas emergentes.

Firefox tiene, por defecto, 
inhabilitadas las ventanas 
emergentes, pero esto 
puede ser modificado 
desde su menú de 
opciones.

IE muestra todas las 
ventanas emergentes 
posibles en la versión 
IE10; no obstante, se 
puede modificar esta 
acción mediante sus 
“Herramientas”.
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XHTML es también conocido como la extension del HTML inicial, pues presenta nuevas 
características en el lenguaje, como la adaptación al lenguaje XML, el cual es muy usado 
por desarrolladores en la actualidad.

DOM

DOM es el Modelo de Objetos del Documento, también llamado Modelo en Objetos para 
la Representación de Documentos. Se podría definir como una estructura lógica de los 
documentos web, porque permitirá administrar los datos u objetos que componen un 
documento web.

Eguiluz (2013) sostiene que “CSS es el mecanismo que nos permitirá separar los 
contenidos definidos mediante el lenguaje XHTML y el aspecto visual que deben 
presentar esos contenidos”.

Contenidos
+

Presentación

XHTML
(Contenidos)

CSS
(Presentación)+

HTML

Fig. 1.6 Modelo web con HTML5 
Fuente: < h  p://www.free-html5-templates.net/charity-centre-free-html5-css3-template/>

Veamos, a con  nuación, una página web realizada completamente en HTML5:
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Con respecto a su 
estructura

HTML5 presenta etiquetas nuevas y usa algunas provenientes de sus versiones 
anteriores, que nos permiten tener una mejor distribución del documento web, mucho 
más ordenado para el diseñador, y con mayor rapidez para el navegador. Con ello se 
consigue un aumento en el dinamismo de la página web. HTML5 no promueve el cambio 
total de las etiquetas sino, más bien, implementa nuevas. Así, deja obsoletas solo 
algunas etiquetas HTML4.

Fig. 1.7 Partes del HTML5
Fuente: <h  p://www.smashingmagazine.com/2009/07/16/html5-and-the-future-of-
the-web/>

Gráficos con Canvas Canvas nos permitirá generar elementos gráficos, estadísticas y, en general, cualquier 
tipo de representación gráfica. Se trata de un elemento incorporado en HTML5 que nos 
permitirá generar imágenes dinámicas por medio de scripts de Javascript.

Control de audio y 
video

HTML5 incorpora de manera nativa un reproductor de contenidos multimedia, para 
sonidos en formato MP3 y videos de formato MP4, mostrando una barra parecida a la 
siguiente imagen:g

La mayoría de las páginas web que ofrecen audio o video dependen mucho de la 
instalación de plugins que permitan dar soporte a estos formatos, como el plugin de 
Adobe Flash, que era muy requerido por los diseñadores de páginas web hasta que salió 
HTML5. Esta innovación causó un gran cambio: hoy se permite ver videos o escuchar 
canciones online, sin tener que descargarlas, solo manejando un reproductor.

Analizaremos algunos cambios notables que presenta HTML5 con respecto a las versiones anteriores:

p g g p p p

Fig. 1.8 Canvas en HTML5
Fuente: <h  p://blog.teamtreehouse.com/how-to-draw-with-html5-canvas>
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Manejo de 
Geolocation

HTML5 está desarrollado para diferentes plataformas (web, móviles, etc.), lo cual explica 
que presente como característica la interfaz Geolocation, que permite determinar desde 
qué lugar se está visualizando un sitio web. Esto se puede realizar gracias a los sistemas 
de referencialización como el GPS.
Asimismo, permitirá al usuario tener una rápida ubicación de la empresa que promociona 
la web, dándole confianza al momento de realizar, por ejemplo, un e-commerce.

Offline Web
Permite navegar a través de la página web sin tener conexión a Internet. Esto se consigue 
descargando, a una pequeña base de datos en nuestra computadora, el contenido de la 
página web que lo implemente.

Etiquetas de 
Formulario

HTML5 ha incorporado una variedad de funcionalidades para la implementación de 
formularios, como el autofocus o validaciones sobre los controles, los cuales antes se 
tenían que realizar mediante Javascript.

1.4    HTML5 y las Hojas de Estilo en Cascada

HTML5 trabaja junto con CSS3, y entre los dos tratan 
de defi nir los nuevos estándares para el desarrollo web 
moderno, tanto para equipos de escritorio como para 
disposi  vos móviles (tablets o iPads y teléfonos celulares). 

CSS, u “Hojas de Es  lo en Cascada” (en inglés Cascading 
Style Sheets), se defi ne como un lenguaje que sirve para 
establecer la presentación de un documento estructurado 
y escrito en HTML5. La organización W3C (World Wide 
Web Consor  um) es la encargada de especifi car las 
propiedades que servirán de estándar para los diferentes navegadores. Esto permi  rá elaborar páginas 
web más elaboradas y dinámicas sin necesidad de recurrir a los lenguajes de programación.

1.5    HTML5 Y JAVASCRIPT

JavaScript, al igual que CSS, es una 
de las herramientas más usadas 
para extender la capacidad que ya 
de por sí  ene el lenguaje HTML5. 
Con esto no damos a entender 
que HTML5 suple las funciones 
de Javascript, sino, más bien, 
se complementan de la mejor 
manera posible. Un caso concreto 
es la implementación de Canvas con HTML5, que usa completamente código Javascript. 
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JavaScript no es un lenguaje de programación propiamente dicho, como Java, C++, Basic, etc. 
Simplemente es un lenguaje script orientado a documentos web. Eso quiere decir que no es posible 
implementar aplicaciones Javascript y que se ejecuten separadamente de un documento web, y mucho 
menos fuera de un navegador. Finalmente, podemos decir que JavaScript es un lenguaje interpretado 
o, mejor dicho, entendido por el navegador que envuelve en una página web HTML5.  

1.6    HTML5 Y JQUERY

¿Se ha preguntado cómo se incorporan algunos efectos en las páginas web, 
como animaciones de imágenes, autocompletar contenidos, etc.? Todo esto 
podría desarrollarse de manera muy complicada usando scripts de lenguajes 
de programación, pero jQuery empaqueta un conjunto de sentencias 
listas para ser usadas por el diseñador de páginas, y estas permiten que el 
diseño sea lo más profesional posible. Por otra parte, una de las ventajas 
más grandes que presenta jQuery es la compa  bilidad de su código con 
todos los navegadores, lo que permite al diseñador despreocuparse de las 
confi guraciones correspondientes.

La librería jQuery, en resumen, nos aporta las siguientes ventajas:

 Permite ahorrar muchas líneas de código, ya que es invocada como una librería dentro del 
documento web.

 Permite aperturar un mecanismo para la captura de eventos dentro de un documento web.

 Permite habilitar un conjunto de funciones dentro de un documento web, convir  endo, de manera 
sencilla, una página básica en dinámica y profesional.

Para visualizar los efectos de jQuery, CSS y HTML5 en un documento web, recomendamos visitar las 
siguientes páginas:

Fig. 1.9 Efectos del JQuery, CSS y HTML5
Fuente: <h  p://headlampcrea  ve.com/ >
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Fig. 1.10 Efectos JQuery, CSS y HTML5
Fuente: < h  p://deda.me/>

Fig. 1.11 Efectos JQuery, CSS y HTML5
Fuente: < h  p://www.dri  boys.com/>
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1.7    HTML5 Y LOS DISPOSITIVOS MÓVILES

Tenemos que considerar que cuando hablamos de disposi  vos móviles en la actualidad no solo nos 
referimos a un teléfono móvil, sino también a smartphones, tablets, televisores inteligentes, etc. En el 
futuro los nuevos disposi  vos tendrán que adaptarse a HTML5 y formar un estándar, lo cual, sin duda, 
ya está ocurriendo ahora mismo.

Hace algunos años, las páginas web se limitaban a mostrar textos e imágenes, y normalmente se 
navegaba en ellas con una computadora de escritorio o una laptop; no se pensaba que en un futuro 
muy cercano habría un despegue desmedido de disposi  vos móviles. En el año 2007 aparecieron los 
iPhones, y su uso se fue extendiendo rápidamente junto con los teléfonos inteligentes (smartphones), 
que añadían a las funciones principales de un teléfono móvil, el leer y enviar e-mails, así como visualizar 
millones de páginas web. 

Actualmente, muchos navegadores web  enen confi guraciones que permiten verlos en disposi  vos 
móviles, tablets, iPads, etc. Por ejemplo, en h  p://html5lounge.com/, usted podrá observar una 
página web que fue diseñada en HTML5, y que puede ser vista tanto desde un disposi  vo móvil como 
desde un navegador web de plataforma. La diferencia está en que desde el disposi  vo móvil el usuario 
puede desplazarse mediante la pantalla tác  l, mientras que en el navegador  ene que hacerlo con el 
teclado. 

Fig. 1.12 HTML5 en los disposi  vos móviles
Fuente: <www.google.com/imagenes>

Fig. 1.13 HTML5 en dispositos móviles
Fuente: < h  p://html5lounge.com/>
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1.8    CUÁL ES LA DIFERENCIA ENTRE W3C Y WHATWG

Hasta el momento hemos usado algunos términos, como W3C y WHATWG. A con  nuación, 
procederemos a explicarlos.

World Wide Web Consortium (en forma abreviada W3C) es un consorcio internacional 
que produce recomendaciones estándares a nivel mundial para el uso de la red. Es 
dirigido por Tim Berners-Lee, el creador original de URL (Uniform Resource Locator, 
Localizador Uniforme de Recursos), HTTP (HyperText Transfer Protocol, Protocolo 
de Transferencia de HiperTexto) y HTML (Hyper Text Markup Language, Lenguaje de 
Marcado de HiperTexto), que son las principales tecnologías sobre las que se basa la 
Web.

Visite su sitio oficial en: http://www.w3.org/

El Web Hypertext Application Technology Working Group está constituido por 
desarrolladores interesados en promover la evolución de HTML. Fue creado por  
integrantes de Apple, Mozilla y Opera.

Visite su sitio web en: http://www.whatwg.org

1.9    REQUERIMIENTOS MÍNIMOS DEL SISTEMA

Comprender HTML es comprender el idioma en el que se manejan las cosas en Internet; por tanto, 
su accesibilidad no depende de la persona (es decir, no se requiere un perfi l de usuario), pero sí 
necesitamos alguna referencia sobre el  po de computadora que necesitamos para desarrollar 
aplicaciones HTML5. Debido a que se trata de un lenguaje sin plataforma, se necesita un entorno 
dónde desarrollarlo, y son los dis  ntos entornos posibles los que defi nen al fi nal los requerimientos. 
Haremos una lista de aplicaciones donde podamos desarrollar los script HTML5 con sus respec  vos 
requerimientos:

Con respecto al Bloc de Notas, no tenemos que explicar mucho, pues esta aplicación 
viene preinstalada en el Sistema Operativo Windows. El mismo sistema solicitará sus 
propios requerimientos. 

Para tener Windows 7 en su equipo, necesitará:

 Procesador de 32 bits (x86) o 64 bits (x64) a 1 gigahercio (GHz) o más.

 Memoria RAM de 1 gigabyte (GB) (32 bits) o memoria RAM de 2 GB (64 bits).

 Espacio disponible en disco rígido de 16 GB (32 bits) o 20 GB (64 bits).

 Dispositivo gráfi co DirectX 9 con controlador WDDM 1.0 o superior.

Para Windows 8.1 en su equipo necesitará:

 Procesador de 1 gigahercio (GHz) o más rápido, compatible con PAE, NX y SSE2 (más 
información).

 Memoria RAM de 1 gigabyte (GB) (32 bits) o 2 GB (64 bits).

 Espacio libre en el disco duro de 16 GB (32 bits) o 20 GB (64 bits).

 Dispositivo gráfi co Microsoft DirectX 9 con controlador WDDM.
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Los requerimientos para Notepad++ son los mismos que se mencionan al respecto del 
Bloc de Notas de Windows, pues esta aplicación, por ser ligera, no necesita muchos 
recursos.

Podrá descargar Notepad++ gratuitamente desde la URL:
 http://notepad-plus-plus.org/download/v6.5.3.html

Komodo Edit es una aplicación de aproximadamente 70 MB y puede ser instalada en 
sistemas Windows y Linux. Los requerimientos mínimos, según el lugar de descarga de 
la aplicación, son:

 Procesador x86 o x86_64

 CPU de 233 MHz o más (se recomienda Pentium III de 500 MHz o superior).

 512 MB de memoria RAM (se recomienda 1 GB o más).

 200 MB de espacio libre en el disco duro.

La aplicación podrá ser descargada desde la siguiente URL:
http://www.activestate.com/komodo-edit/downloads

Dreamweaver CS6 es la aplicación de diseño web de Adobe más usada para la 
implementación de páginas web. Sus requerimientos son los siguientes: 

 Procesador Intel Pentium 4 o AMD Athlon 64

 Sistema operativo Microsoft Windows XP con Service Pack 3, o Windows 7 con Service 
Pack 1. Adobe Creative Suite 5.5 y las aplicaciones CS6 también admiten Windows 8 
y Windows 8.1. 

 512 MB de memoria RAM.

 1 GB de espacio libre en disco duro para la instalación; se necesitará espacio libre 
adicional durante la instalación (no se puede instalar en dispositivos extraíbles de 
almacenamiento basados en memoria fl ash).

 Pantalla de 1280 x 800 con adaptador de gráfi cos de 16 bits.

 Java Runtime Environment 1.6 (incluido).

 Unidad de DVD-ROM.

 Software QuickTime 7.6.6 para reproducción multimedia de HTML5.

Por otra parte, este software no funciona si no se ha activado. Para la activación de 
software, la validación de suscripciones y el acceso a servicios en línea se necesita una 
conexión a Internet de banda ancha y realizar el registro. La activación por teléfono no 
está disponible.

Sublime Text es un editor de código muy ligero. Su característica principal es que 
presenta los documentos web en fichas amigables y, así como los lenguajes de 
programación, colorean las palabras reservas del lenguaje HTML5. 

Asimismo, el Sublime Text presenta una interfaz, que se apoya en  un minimapa del 
código, y un QuickPanel, que permite navegar de manera adecuada por el codigo 
desarrollado.

Se puede descargar desde la siguiente URL: http://www.sublimetext.com/2
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1.10    CÓMO DETERMINAR SI MI NAVEGADOR ESTÁ PREPARADO PARA HTML5

Tras todo lo mencionado sobre HTML5, debemos considerar que en esta versión hay más e  quetas y 
más opciones, lo que nos deja la duda de si desde nuestro navegador podemos acceder a todo lo que 
ofrece HTML5. En este caso, recomendamos analizar el navegador mediante un test. Acceda a la URL 
h  p://html5test.com/ para analizar su navegador:

Fig. 1.14 Test de HTML5
Fuente: <h  p://html5test.com/>

Fig. 1.15 Categoría del test de HTML5
Fuente: <h  p://html5test.com/>

Consideremos los siguientes aspectos:

 El test muestra las categorías y sus caracterís  cas.

Categoría El valor 28 representa el 
total de caracterís  cas 
ac  vas en su navegador, 
de un total de 30 en la 
categoría Audio.

Caracterís  cas 
según la categoría.
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 La puntuación que se muestra se calcula mediante el análisis de muchas nuevas caracterís  cas de 
HTML5. Cada una  ene un valor de uno o más puntos.

 Además de las especifi caciones HTML5 principales, se toman en cuenta otras especifi caciones de la 
W3C, e incluso de WEbGL, que, a pesar de no ser desarrollada por la W3C, también forman parte 
de la prueba.

 Si la puntuación es muy baja, la solución será actualizar el navegador o, en todo caso, cambiarlo por 
uno que se adapte mejor a HTML 5.

Veamos una tabla compara  va entre los diferentes navegadores web, según sus versiones hasta el año 
2013 y los requerimientos de dis  ntos lenguajes (HTML4, HTML5, etcétera).

1.11    COMPRENDIENDO LA URL

La URL, o Localizador Uniforme de Recursos, permite al navegador encontrar una dirección web en la 
Internet. La URL se compone de un nombre del servidor, probablemente la carpeta donde se encuentra 
el documento web a visualizar, el nombre del archivo web y el protocolo a usar para recuperar los 
datos.

Formato:

Fig. 1.16 Compara  vo entre los navegadores web
Fuente: <h  p://html5.komple  .cc/code/chap_intro/  meline.html?lang=en>

h  p://www.servidor.com/directorio/pagina.html
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Donde: 

 h  p: Es un protocolo de comunicación entre el navegador y el servidor web. Asimismo, este defi ne 
un conjunto de reglas para que el navegador y el servidor se comuniquen con claridad, también 
podemos usar: 

 h  ps: h  p sobre ssl (Secure Sockets Layer), proporciona comunicaciones seguras en Internet.
  p: File Transfer Protocol, o Protocolo de Transferencia de Archivos.
 mailto: Des  nado para direcciones de correo electrónico.
 fi le: Des  nado para recursos disponibles en la computadora o en una red local.

 www.servidor: Es el nombre completo de la web; por ejemplo, google en www.google.com. Es un 
nombre único que iden  fi ca al si  o web.

 Com: Es conocida como la extensión del dominio, las cuales se clasifi can en genéricas (.com, .net, 
.org, .info, .biz) y geográfi cas (.pe, .es, .jp, .fr, .us, etc.).

 Directorio: Los directorios son carpetas que permiten la organización de un proyecto web, que 
algunas veces recibe el nombre de si  o web. Hay un lugar llamado Directorio Principal que permite 
alojar todos los archivos de un proyecto web, inclusive más directorios.

 Página.html: Es el nombre del documento que se presentará en el navegador. Por defecto el nombre 
es index.html pero eso dependerá del si  o web.

1.12     IMPLEMENTANDO UN DOCUMENTO WEB HTML5 CON BLOC DE NOTAS

Logros:

 Al fi nal del caso propuesto, usted podrá reconocer los nuevos elementos que componen el 
lenguaje HTML5.

 Podrá implementar una página web usando el script HTML5 en un Bloc de Notas de Windows.

Tener en cuenta: 

 Debe usar el Bloc de Notas como medio de implementación del script HTML5.
 Grabe el archivo como index_bloc.html en la Unidad C:
 Use estrictamente e  quetas HTML5.
 Pruebe el script HTML5 usando Internet Explorer, Firefox y Chrome.

Pasos para la solución:

a. Acceso a la aplicación  
El acceso al Bloc de Notas es bastante conocido, así que obviaremos dichos pasos y pasaremos al 
siguiente punto.
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<!DOCTYPE html>
 <html lang="es">
 <head>
   <title>Título de la web</title>
 </head>
 
 <body>
    <header>
       <h1>Mi sitio web</h1>
       <p>Mi sitio web creado en html5</p>
    </header>
    <section>
       <article>
           <h2>Título de la sección<h2>
           <p>Contenido (además de imágenes, citas, videos, etc.) 
</p>
       </article>
    </section>
    <aside>
       <h3>Título de la sección</h3>
           <p>contenido</p>
    </aside>
    <footer>
        Todos los derechos reservados @2014
    </footer>
</body>
</html>

c. Grabar 
 Seleccionar Archivo > Guardar como…

 Asignar el nombre index_bloc.html. Usted  ene que colocar la extensión HTML de forma 
obligatoria, de otra manera se asignará la extensión .txt

d. Probar la página web
Debido a que usted  ene un navegador predeterminado en su computadora personal, habrá 
notado que, al guardar el archivo, el ícono justamente le fue asignado desde dicho navegador. 
Para poder probar la página en diferentes navegadores, primero debemos cargar el que usaremos 
y, luego, arrastrar el archivo sobre el contenido del navegador. Eso es lo que hemos realizado para 
esta prueba.

b. Crear un nuevo documento y codifi car con HTML5
Al iniciarse la aplicación Bloc de Notas, esta nos muestra una página en blanco donde digitaremos 
el script HTML5. Pero si necesitamos crear un nuevo documento, accederemos desde Archivo > 
Nuevo y colocaremos el siguiente código:
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Mostramos los resultados que se muestran en diferentes navegadores.

´

´

´

´

´

Fig. 1.17 Web desde Internet Explorer

Fig. 1.18 Web desde Google ChromeFig 1 18 Web desde Google Chrome

´

´

´

´

´



CAP. 1:  INTRODUCCIÓN  AL DISEÑO WEB CON HTML5 Y CSS3 37

Fig. 1.19 Web desde Mozilla FirefoxFi 1 19 W b d d M ill Fi f

´

´

´

´

´

1.13     IMPLEMENTANDO UN DOCUMENTO WEB HTML5 CON KOMODO EDIT

Logros:

 Al fi nal del caso propuesto usted podrá implementar una página web HTML5 en Komodo Edit.

Tener en cuenta: 

 Debe usar la aplicación Komodo Edit como medio de implementación del script HTML5.
 Grabar el archivo como index_komodo.html en la Unidad C:
 Use estrictamente e  quetas HTML5.

Pasos para la solución:

a. Acceso a la aplicación
El acceso al Komodo Edit se puede efectuar haciendo doble clic sobre su ícono. 
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b. Crear un nuevo documento y codifi car con HTML5

 File > New > File from Template
 Seleccione la Categoria: Common (1)
 Seleccione Templates: HTML5 (2)
 Asigne el nombre del archivo como: index_komodo (3)
 Asigne el directorio C:\ como lugar para grabar el archivo, esto lo realizará presionando el botón 

Local… (4)
 Finalmente presione Open para crear el archivo (5)

Fig.1.20 Nuevo archivo desde Komodo Edit

Digite el siguiente script:

<!DOCTYPE html>
 <head>
   <title>Título de la web</title>
 </head>
 
 <body>
    <header>
       <h1>Mi sitio web</h1>
       <p>Mi sitio web creado en html5</p>
    </header>
    <section>
       <article>
           <h2>Título de la sección<h2>
           <p>Contenido (además de imágenes, videos, etc.) </p>
       </article>
    </section>
    <aside>
       <h3>Título de la sección</h3>
           <p>contenido</p>
    </aside>
    <footer>
        Todos los derechos reservados @2014
    </footer>
</body>
</html>
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c. Grabar y probar
 Para grabar los cambios presione File > Save.
 Para probar presione View > Browser Preview y se mostrará de la siguiente manera: 

1.14     IMPLEMENTANDO UN DOCUMENTO WEB HTML5 CON SUBLIME TEXT

Logros:

 Al fi nal del caso propuesto usted podrá implementar una página web HTML5 en la aplicación 
Sublime Text.

Tener en cuenta: 

 Debe usar la aplicación Sublime Text como medio de implementación del script HTML5
 Grabar el archivo como index_sublime.html en la Unidad C:

 Use estrictamente e  quetas HTML5

Fig. 1.21 Vista previa desde Komodo Edit
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Pasos para la solución:

a. Acceso a la aplicación
El acceso a Sublime Text se puede efectuar haciendo doble clic sobre su ícono.

 

b. Crear un nuevo documento y codifi car con HTML5
Al iniciar la aplicación ya se presenta un documento nuevo, pero podemos crear uno seleccionando 
File > New File y colocar el siguiente código:

<!DOCTYPE html>
 <html lang="es">
 <head>
   <title>Título de la web</title>
 </head>
 
 <body>
    <header>
       <h1>Mi sitio web</h1>
       <p>Mi sitio web creado en html5</p>
    </header>
    <section>
       <article>
           <h2>Título de la sección<h2>
           <p>Contenido(además de imágenes, videos etc.) </p>
       </article>
    </section>
    <aside>
       <h3>Título de la sección</h3>
           <p>contenido</p>
    </aside>
    <footer>
        Todos los derechos reservados @2014
    </footer>
</body>
</html>
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c. Grabar 
 Seleccionar File > Save
 Asignar el nombre index_sublime

Fig. 1.22 Vista de código desde Sublime Text 
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